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INTRODUCTION 

Mission Statement – Our goal at The Back Office, LLC is to provide high quality, highly functional 
software that enables users to be more productive, more competitive, and most importantly more profitable.  
Keeping in mind that our software handles critical business functions, we at The Back Office, LLC design all 
our software to be flexible, stable and reliable.  We stand behind our products and are confident they will 
meet or exceed expectations. 

What is Accounting Link? 
Accounting Link allows users to extract accounting related information from the  
R.O. Writer TM   software program and transfer it directly into their accounting system.  Accounting Link 
acts as a bridge, transferring information from R.O. Writer TM to your accounting system while allowing 
users to review and verify the information before it is transferred.   
 
Who is The Back Office, LLC? 
The Back Office has a partnership with R.O. Writer TM to provide a simple, easy to use accounting 
interface.  The Accounting Link was written by a CPA (the founder of The Back Office, LLC) and is 
supported by accounting professionals who have experience with automotive industry accounting issues.  We 
pride ourselves on superior customer service and support and we will be with you to provide ongoing 
technical support. 
 
What type of information can be transferred?  
Accounting Link allows you to transfer the following information from R.O. Writer TM directly into your 
accounting system.     
 
Closed Repair Orders 

• Sales income (either in summary or in detail) 
• Sales tax collected 
• Payments collected (Cash, Checks, Credit Cards, Charges etc) 
• Supply charges 
• Other fees charges (battery fees, tire disposal, etc) 
• Discounts given (parts, labor, sublet and fleet) 
 

Advance Payments collected on Repair Orders 
 
Accounts Receivable Transactions 

• Payments posted on open accounts 
• Misc. charges posted on customer accounts (including finance charges etc) 
 

Accounts Payable Transactions 
• Invoices from suppliers 
• Payments on invoices 

 
Inventory Transactions 

• Transfers from Inventory to Cost of Goods Sold as parts are sold 
• Inventory purchases (handled through Accounts Payable) 
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What Accounting Programs does Accounting Link work with?  
Accounting Link currently works with the following Accounting systems: 
 
QuickBooks® 
Peachtree® 
DacEasy® 
AccPac® 
MAS90©    
Great Plains© 
Business Works© 

Multiledger® 

MYOB® 
 
 
What kind of support is offered with Accounting Link? 
THE BACK OFFICE, LLC. prides itself on superior personalized customer support for all of our products.  
We will assist you with installation, setup, and configuration and provide ongoing support as you need it.  
THE BACK OFFICE, LLC. will also make available to users, who are current on support fees, the newest 
updates and versions of software as they are released.   
 
How can I reach The Back Office, LLC if I have questions? 
We can be easily reached toll free at 1-866-964-9699.  You can also email us at BILLF@TBOFFICE.NET ,  
fax us at 515-964-5779 or check out our website at WWW.TBOFFICE.NET.   
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CHAPTER 1 – Basic ACCOUNTING LINK Setup 

There are four basic steps involved in the setup of Accounting Link: 

1) Installing Accounting Link 

2) Registering Accounting Link 

3) Setting up store information 

4) Setting up users and passwords 

 

Installing Accounting Link: 

Put the Accounting Link CD in the proper drive, the screen shown below will appear.  Click on Accounting 
Link Full Install/Update (circled) to begin installing the program.   
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Next you will be prompted through several Accounting Link install/setup screens.  The following is a 
chronological list of those screens. 

1. Run Screen – shows what program is to be installed and where.  Click Ok to 
continue.  

2. Accounting Link Setup – This a welcome screen.  Click Next to continue. 

3. License Agreement – Click in the appropriate box if you agree to the terms of the 
agreement and then Next to continue. 

4. User Information – Prompts you to enter your name and the company’s name.  Click 
Next to continue. 

5. Version – Select Standard or Professional version. Click Next to continue. 

6. Installation Folder – Shows where the program will be stored.  Click Next to 
continue. 

7. Shortcut Folder – Shows the folder the program will be stored in.  Click Next to 
continue. 

8. Ready to Install – Click Install to begin the installation.   

9. Installing Files – The program will begin its installation.  A progress indicator will be 
displayed as the program installs. 

10. Installation Complete – Installation is done, click Finish to end. 

Registering Accounting Link: 

In order to use Accounting Link you must register it with The Back Office, LLC.  Registering the product 
allows you to keep users up-to-date for support and maintenance purposes.  To register the Accounting Link 
software, open the Accounting Link program and click on Setup: 

To open The Accounting Link program do one of the following: 

a) Double click on the  icon on your Windows desktop. 
 
OR 

b) Click on the  button in the lower left corner of the screen. 

    Click on the  option in the Start menu. 
    Click on the  option in the Programs menu. 
    Click on the  option in the TBOffice menu. 
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You will be prompted during initialization of the program to register: 

 

Click OK to continue opening the program.  The Security Check prompt will appear (Figure 1.1): 

The default UserID is TBO, and the default password is “password”.  Type this UserID and password in at 
the Security Check window to access the program.   Ensure that the “Auto Open” option is not selected.  The 
main program will open: 

                                                 

 (Figure 1.1) 

 

Select the Setup option on the right side of the screen to enter the Setup Menu (Figure 1.2): 

 

 (Figure 1.2) 
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Double click on the Register icon (Figure 1.3) in Accounting Link Setup Menu to register the software.   

 

 

 

 (Figure 1.3)  

 

The Registration screen will appear (Figure 1.4): 

                                         

 

 

 

 

 

 (Figure 1.4) 

 

(Figure 1.4) 

Enter all of the Company and Contact information in the appropriate fields, and then select the Accept option 
in the lower left corner of the screen.  You can click on the View button to view the full license agreement.  
Fill in the “Accepted by” name and date.  Make sure that you use a valid email address that you can check 
from the computer you are installing the program on.   

 

Verify that you are connected to the Internet and click the ( ) icon to send the registration 
information to The Back Office, LLC.  The Status screen will display the progress of the registration. 

Once you have completed these steps, a verification email will be sent from The Back Office, LLC to the 
email address that was entered in the Registration screen.  This email verifies that you have attempted to 
register the product.  Once the order has been confirmed with the reseller you will receive email notification 
with instructions on how to unlock the product.   
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Setting up Store Information: 

In order to import information from your R.O. Writer TM database, you must set up the data path in 
Accounting Link.  Select the Locations option in the Accounting Link Setup menu (Figure 1.5).    

 

 

 

 (Figure 1.5) 

 

The Add New location option will be displayed (Figure 1.6).   

Enter a Location ID (up to 3 letters), Location, Description, Minimum Refresh (Starting) Date and a 
QuickBooks® class (if applicable).  Select either DOS or Win/Access and then click on the select icon ( ) 
to the left of the Type field to browse to the data location. The Select a File window will appear (Figure 1.7). 

 

 

 

 

 

 

 (Figure 1.6) 

The File Selection (Figure 1.7) window will default to “My Computer”. 

 

 

 

 

 (Figure 1.7) 
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Use the Windows drop down icon ( ) to the right of the “Look in:” window to browse to your database 

location. Once you’ve located the database, click on Open ( ) in the lower right corner of the 
browse window to return the database name to the setup screen.  Note that Accounting Link will identify the 

type of database for you and put the path into the path location at the same time.  Click on the ( ) icon 
to save the information as entered.  Then click on the X ( ) in the upper right hand corner to exit the store 
setup and return to the main Setup menu. 

 

Setting up Additional Users: 

Accounting Link gives you the option of setting up two types of users:  Administrator and Standard.  

A user with Administrative rights will have access to all menus in the program, including Store and User 
setups.  A user with Standard rights will not be able to access any of the options in the Setup screen. 

To set up additional users, select the Users icon in the Accounting Link Setup screen (Figure 1.8): 

 

 

 

 (Figure 1.8) 

Note:  You must be logged on with Administrator login rights to add, change or delete users.  The default 
login has admin rights that cannot be removed.  However, the default password can be changed. 

 

In the User screen (Figure 1.9), enter a User ID, Description and Password for the additional user.  If you 
want the user to have Admin rights, click on the box next to Admin at the bottom of the screen.   

 

 

 

 

 

 (Figure 1.9)  
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If the user is to be a Standard User, leave the Admin box unchecked (Figure 1.10).  Click ( )  icon to 
add the user.   

 

 

 

 

 

 

 (Figure 1.10) 

Options: 

The Options menu contains some of the basic configuration setups for Accounting Link (Figure 1.11).  Note: 
only users with Admin rights will be allowed to access this part of the program.   

 

 

 

 

 (Figure 1.11) 

The Options screen will be displayed (Figure 1.12):  Note: There are 5 main classifications listed in the 
Options Screen; 1. Maintenance, 2. Entry Preparation, 3. GL Mapping, 4. Export Options, 5. Advanced 
Options.  Refer to the following pages for detailed descriptions on each topic. 

 

 (Figure1.12) 
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Maintenance 

The Maintenance section (Figure 1.13) allows you to set the backup and data paths for Accounting Link. 
Left click on the option you wish to change and then left click on the file select icon ( ) to browse to the 
new location.     

The Data path is the location in R.O. Writer TM where the Accounting Link will gather data from. 

The Backup data path is the location Accounting Link files will be sent when you use the backup option in 
Accounting Link. 

          

 

 

 

 

 (Figure 1.13) 
 

Entry Preparation 

The Entry Preparation screen (Figure 1.14) allows you to decide whether you want your accounting to be 
based on Split Ticket or Job Based format.  You should only select Job Based if you have R.O. Writer TM 
set up for Job Based Repair orders. 

 

 

 

 

 

 (Figure 1.14) 

Split Ticket – Split Ticket is a configuration used by R.O. Writer TM to classify revenue.  This setting separates 
Labor (category) revenue from Parts (department) revenue.   

Job Based – Job Based is a configuration used by R.O. Writer TM that groups parts associated with labor jobs 
on an R.O.  All parts used are associated with their respective labor jobs.   
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GL Mapping 

The GL Mapping section (Figure 1.15) allows you to configure options that control how sales revenue can 
be broken down in your accounting system.                                                                                          

Summary Level – This option groups all Sales into 3 types; labor, parts, and sublet. 

Category/Department – Allows users greater detail to for classifying sales revenue; parts, labor, and sublet 
together.  Note: Only Accounting Link Pro users will have this option. 

Tax/Non Tax Settings – Allows users to separate taxable and non taxable parts, labor and sublet revenue. 

 

 

 

 

 

 

 

 (Figure 1.15) 

Export Options 

The Export Options screen (Figure 1.16) allows you to configure what type of accounting software you are 
using, as well as the location of the export file and the default file name.  

 

 (Figure 1.16) 
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Advanced Options 

The Advanced Options screen (Figure 1.17) allows for configuration for some specialized settings.  The 
need for these settings will be discussed with you by Accounting Link technical support during setup and 
configuration.  

 

 

 

 

 

 

 

 

 

 

 

(Figure 1.17) 
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CHAPTER 2 – Accessing ACCOUNTING LINK 

Open Accounting Link: 

 
To open The Accounting Link program do one of the following: 
 

a) Click on the  icon on your Windows desktop. 
 
OR 
                   

b) Click on the  button in the lower left corner of the screen. 

    Click on the  option in the Start menu. 
    Click on the  option in the Programs menu. 
    Click on the  option in the TBOffice menu. 
 
Log into Accounting Link program: 

Accounting Link is a password protected program that ensures only users that have permission to be in the 
program are the ones with access.  To open The Accounting Link you must enter your UserID and password 
into the “Security Check” screen that displays then the program starts. 
 

 
 

• Select a user from the drop down list next to ‘UserID’ 
• Type the correct password for that user in the text box labeled ‘Password’. 
• Selecting the ‘Auto Open’ check box will automatically open the Quick Prepare menu to begin your 

daily processing.  If you deselect the ‘Auto Open’ option, you will have access to the setup menu to 
modify Accounting Link configurations. 

 
Note:  The default UserID is ‘TBO’ and the default password is ‘password’.  The default UserID cannot be 
deleted but the administrative password can be changed as needed. 
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CHAPTER 3 – Daily Transaction Processing 
 

The Accounting Link captures information from R.O. Writer TM and allows the user to verify and or edit 
that information before transferring it to their accounting software.   The Accounting Link makes the transfer 
of information from R.O. Writer TM into your accounting software a simple, highly accurate 4 step process.  
 

1) Quick Prepare: In this section you will select the date or dates for which you would like to transfer 
information.  Once  
Quick Verify:  In this step you have the ability to verify that the information which was prepared, 
matches with the activity R.O. Writer TM reported for the day.   

2) Deposit: In this (optional) step you can verify that the deposit slip you have prepared matches the 
detail of the entries listed.  This step allows you to account for items such as Cash Over/Short and 
validate your cash related items before they are physically deposited in the bank. 

3) Export: in this step you will export the entries that you have prepared and verified to a file that can 
be imported into your accounting system. 

 
 
Quick Prepare: 

From the main Accounting Link Screen (Figure 1.18) double click on the Prepare Option to access the Quick 
Prepare Screen. Note:  If you open the Accounting Link with the Auto Open check box checked, you will be 
taken directly into the Quick Prepare Screen. 

 
 

 
 (Figure 1.18) 
 
 
 
In the Quick Prepare screen (Figure 1.19 on p.19):  

 
• Select the store location you would like to prepare entries for from the 

( ) drop down list in the upper right hand corner of the 
screen. 

• Select the date in the “Dates to Process” window you would like to review before it is 
transferred into your accounting package.    

 
Note: When a date shows up in the “Dates to Process” window, it means that activity from R.O. Writer TM 
has been closed to that date and has not yet been processed by the Accounting Link. 
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 (Figure 1.19) 
 

• Click on the Select ( ) option below the Dates to Process window to access the 
R.O. Writer TM data for the selected date. 

• Accounting Link will retrieve the current information for the date you selected from R.O. 
Writer TM and display it on the Quick Prepare Screen.  A progress bar (Figure 1.20) will 
display as the program retrieves the data. 

 
 

 
 

 
 
 

 (Figure 1.20) 
 
• The Sales Summary, Cost of Parts, Payments Received, Other Summary, 

Receivables/Payables sections will display all of the information gathered from R.O. 
Writer TM.   

• You can compare these figures to your R.O. Writer TM summary report to ensure 
everything is correct.  If you would like a paper copy of the Accounting Link summary 
click the Print icon at the bottom of the screen. 
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• If you would like to change or edit the journal entries please refer to the next section on 
Page 20 entitled Verify the Journal Entries. 
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Verify the Journal Entries: 

Select the Details tab (Figure 1.21) in the upper left corner of the display to view the detailed information for 
the day selected.  A listing of all of the transactions selected for that date will be displayed on the Details 
Screen.  
 

 
 (Figure 1.21) 

 
 
A listing of all transactions for the selected day will be displayed (Figure 1.22): 

 

 
 
 (Figure 1.22) 
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Using the Reset, Void, Hold, and Delete Features 
Note: All of the following procedures are performed in the Details tab of the Quick Prepare Screen. 
• To delete an item, left click on the line item, then left click on ( ) .  This will delete the 

item from the Accounting Link.  Deleting an item from the Accounting Link will allow for the 
item to be re-prepared with the most current R.O. Writer TM data.  If you do not want an entry to 
be re-prepared then you need to Void the item.  Refer to the next bullet point for information on 
Voiding. 

• To void an item, left click on the line item, then left click on ( ). Voiding a transaction 
will stop it from being re-prepared by the in Accounting Link even though it remains in R.O. 
Writer TM and unprocessed by the Accounting Link.  The transaction will remain in Accounting 

Link.  To view voided transactions check the  box 
to see them.  You can unvoid a transaction by selecting it from the list and clicking the 
( ) button.  Resetting a transaction makes it available for Export. 

• Putting a transaction on Hold simply holds it in the Accounting Link so it won’t be available to 
Export.  To assign an item to be held, left click on the line item, then left click on ( ).   
To take a transaction off hold check the On Hold option on the right side of the screen to view it 

, select the transaction(s) you want to take off 
hold, then select it from the list and click ( ).   

• To view items that were previously exported select the Exported option on the right side of the 

screen to view them . 
• To reset any item to it’s original state – that is to change its status to unexported, not on hold and 

not voided – left click on the line item, then left click on ( ).   
• Selecting the “All dates” option and nothing else will display all transactions that have not yet 

been exported, are not on hold or have not been voided.   
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Editing Journal Entries 
• To view or edit details for any entry on the details page, double click on the entry.  A detailed 

view of the entry will be displayed similar to Figure 1.23 displayed below.  You can edit any 
entry type from your sales entry, to an A/P entry, to your inventory entries.  Accounting Link 
allows users to edit debit and credit amounts, vendors items are charged to, and accounts that 
transactions are recorded to. 

 
Note:  If you plan on editing transactions in R.O. Writer TM   it is possible for Accounting Link to pull those 
edited transactions over again.   

 

 
 (Figure 1.23) 

 

When finished viewing/editing the entry, click on the ( ) icon in the upper left corner of the edit screen 
to return to the Quick Prepare details screen. 
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Verify Deposit - Optional: 

Note:  it is not required that you perform this step in order to transfer deposit information into your 
accounting package.  This is an optional step that allows you make and easily edit a deposit entry and print 
a standard deposit slip before transferring. 
 
When sales are transferred into Accounting Link, the amounts collected for them are generally mapped to an 
undeposited funds or bank clearing account in your accounting system.  When information is exported out of 
Accounting Link and imported into your accounting system this account will show a balance to signify that 
you have funds that need to be deposited.  The Deposit feature will allow you to make a deposit entry before 
exporting.  This is basically a reversing entry to take amounts out of undeposited funds or the bank clearing 
account and put them in your bank account.  Users can choose to skip this step in Accounting Link and 
prepare their deposit in their accounting system. 

To use the Deposit feature, select the ( ) icon in the main toolbar of the Quick Prepare screen.  
 
The Deposit screen (Figure 1.24) will be displayed with a listing of all cash, checks, and charges collected 
for the day. 
 

 
 (Figure 1.24) 
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• If all of the entries are accurate, click on  to include them in the deposit.   
• If a check is to be held, you can unselect it by left clicking in the check box to the left of 

the entry.  The check will not be included in the deposit. 
• You can edit transactions in the Deposit screen to reflect a short/over or a petty cash 

adjustment before transferring to the accounting system. 
 
Another optional step is to print a deposit slip based on the information contained in this Deposit screen.  
You can purchase preprinted deposit slips from Intuit (QuickBooks®) that will match up to the format of the 

Accounting Link deposit.  Click on the ( ) icon in the toolbar at the top of the screen to print a deposit 
ticket.  The program will ask you to confirm that you want to print a deposit ticket.  You will want to make 
sure the deposit slip is in the printer before clicking Yes. 
 

 
 
 

Once the deposit ticket has been printed or you are ready to post, you will select the Post icon ( ) in the 
toolbar to post the deposit.  This will create a Deposit entry in the Accounting Link which can be viewed by 

clicking the ( ) tab in the Quick Prepare Screen. 
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Exporting Journal Entries: 

Once you have reviewed the summary and details screens in Accounting Link, and made your deposit 
(optional), you are ready to export.  Select the Export tab.     
 

 
 
 

• A list of all prepared entries ready for export will be shown in the Export Screen (Figure 
1.25). 

• To select all of the items to be Exported, left click on the Select All icon.   
• To deselect a particular item, hold down the Ctrl key on your keyboard and left click on that 

item.  This step can be performed for multiple items. 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 (Figure 1.25) 
 

• The export file name is a user configurable field.  Left click in the field and then type in the 
desired file name you want to change it to.  The default filename is Export.iif. 

• Select the “Include Date in Export File Name” option to automatically add a date to the 
filename when it is exported.  A six-digit date will be added to the beginning of the file name, 
corresponding with the most recent date attached to the accounting information contained in 
the file. 
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• Once all of the desired items are highlighted, click on the Export icon to create the export file 
in the directory specified in Setup.  You maybe warned that the file already exists and will be 
asked if you want to overwrite it.  If you have not imported the last file you exported into your 
accounting system the new file will overwrite the old one if you say OK.  It is important that 
you are importing these files into your accounting system in a timely manner so you don’t 
unintentionally overwrite files that have not been imported. 

 
 

Import the file into your accounting system: 

Note: Each accounting system has different ways of importing files.  Below is an example of the procedure 
you should use if you have QuickBooks®.  For questions on importing into your accounting system please 
contact technical support at 1-866-964-9699.    

QuickBooks®: 

To import exported Account Link information into QuickBooks®, perform the following steps: 

• Open the QuickBooks® Program. 

• Click on the File Menu in the upper left corner of the screen. 

 

• Select the Utilities option on the File Menu.  A sub menu will appear. 

• Select the Import option on the Utilities Sub Menu.  An Import sub menu will. 
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• Select the Import IIF Files option.  Note: Newer versions of QuickBooks® may have the Import 
option located under the file menu differently.  

• A browse window will appear.  QuickBooks® will always default to the default program directory 
for QuickBooks®.  If you have your export path set to a different location in the Accounting Link 
Setup (See Chapter 4, Configuration for information on changing the default path in Accounting 
Link) you will need to browse to that alternate location.   

• Once you have located the exported file, highlight it in the browser window (Figure 1.26) and 
click on the Open icon to import your data. 

 

 

 (Figure 1.26) 
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• When the process is complete, a prompt will appear to notify you that your information has been 
imported (Figure1.27). Information exported from Accounting Link will be automatically added 
to your accounts in your accounting program. 

 

 (Figure 1.27) 

Note: You can easily view all activity that was imported into QuickBooks® for any given day(s) by going into 
the Reports menu, Accountant & Taxes, then select Journal.  This will display all the journal entries 
including anything that was imported for the day(s) selected.  
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CHAPTER 4 – Advanced Configuration 

This section of the manual contains a brief overview of the Advanced Configuration options.  This section is 
meant to be a reference as Accounting Link technical support will provide you with personalized assistance 
with all of the following procedures during installation and setup.   For more detailed information or 
assistance in configuring Accounting Link to work with your accounting software, please contact technical 
support at 1-866-964-9699.   

Importing, Deleting, Adding and Removing GL Accounts: 

To access the Setup screen (Figure 1.29), first open the Accounting Link program.   

Click on the ( ) icon to open the setup window.  Click on the ( ) icon to begin setting up GL 
Accounts. 

This section of the program allows you to edit, import and or delete specific accounts within your Chart of 
Accounts: 

    

 (Figure 1.29)               
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Note: Accounting Link will have a default chart of accounts setup so users can add or remove items from it, 
or users can import an existing chart of accounts from an accounting software system (QuickBooks®, 
Peachtree®, etc.).   

• Select the Add icon ( ) to add a new account. 

• Select the Remove icon ( ) icon to remove a selected account. 

• Select the Import icon ( ) to import a chart of accounts that were exported from your 
Accounting system.  Typically when importing your chart of accounts from your accounting 
program you can delete Accounting Link’s default chart of accounts.  Refer to the next bullet for 
instructions on deleting. 

• Select the Delete icon ( ) to delete the entire Chart of Accounts. 

• Select the Close icon ( ) to return to the Location setup screen. 
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Mapping the Chart of Accounts: 

Mapping your R.O. Writer TM accounts to your GL Chart of Accounts is performed in the Location Setup 
screen.  This section contains a brief overview of what GL Account sections are associated with which 
accounts in R.O. Writer TM.  For more detailed instruction on mapping GL Accounts, contact Accounting 
Link technical support at 1-866-964-9699. 

Category  

The Category tab is associated with the Labor Categories set up in R.O. Writer TM.  If you add a new Labor 
Category in R.O. Writer TM, you will need to go into this section of the Accounting Link setup to assign it 
to the proper GL Account.  If a new labor category is added in R.O. Writer TM after the initial Accounting 
Link mapping and setup is complete, you may get a message saying setup is not complete.  This is just a 
reminder that you need to map the new category in the Accounting Link. 

 

 

 

 

 

 

 

 

 

 (Figure 1.30) 

Note: If you are using the summary level option you will not have to do any Category or Department level 
mapping. 

Example – If you add a labor category in R.O. Writer TM called Aftermarket Installation, you must go into 
the Setup Screen of the Accounting Link under the Category tab and map a labor sales account you want the 
new labor category to be recorded to.  You must also choose a sublet sales account you want this labor 
category to be mapped to in the event that the work is outsourced.    



User Manual                                           ADVANCED CONFIGURATION
 

32 
 

Department 

The Department tab (Figure 1.31) is associated with the Parts Departments set up in R.O. Writer TM.  If you 
add a new Parts Department in R.O. Writer TM, you will need to go into this section of the setup to assign it 
to the proper GL Account. If a new parts department is added in R.O. Writer TM after the initial Accounting 
Link mapping and setup is complete, you may get a message saying setup is not complete.  This is just a 
reminder that you need to add the new department in the Accounting Link. 

 

 

 (Figure 1.31) 

Note: If you are using the summary level option you will not have to do any Category or Department level 
mapping. 

 

Example – If you want to add an Aftermarket Parts department in R.O. Writer TM you must go into the 
Setup screen of the Accounting Link and map which account you would like sales for that new department 
going to.  You must also choose a Cost of Goods Sold account and an Inventory account for the new 
department. 
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GL Account(s) 

The GL Account section (Figure 1.32) is associated with various income and sales related accounts.  During 
this part of the mapping process, Accounting Link technical support will help you choose which accounts in 
your accounting system you would like information from R.O. Writer TM to be transferred to.  

 

 (Figure 1.32) 

Other Fees 

The Other Fees section (Figure 1.33) is associated with the Other Taxes and Fees set up in the R.O.  
Writer TM software Remember if you add a new Fee in R.O. Writer TM, you will need to go into this section 
of the setup to assign it to the proper GL Account. 

 

 

 

 

 

 

 

 (Figure 1.33) 
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Credit Cards 

The Credit Cards section (Figure 1.34) is associated with the Forms of Payment set up in R.O. Writer TM.  
Remember, if you add a new Form of Payment in R.O. Writer TM, you will need to go into this section of 
the setup to assign it to the proper GL Account. 

 

 (Figure 1.34) 

Payables 

The Payables section (Figure 1.35) is associated with the GL Accounts, Expense accounts set up in R.O. 
Writer TM.  Remember, if you add new expense accounts in R.O. Writer TM, you will need to go into this 
section of the setup to assign it to the proper GL Account. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 (Figure 1.35) 
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Shop Cards 

The Shop Cards section (Figure 1.36) is associated with the GL Accounts, Shop Cards set up in R.O. 
Writer TM. Remember, if you add new Shop Cards in R.O. Writer TM, you will need to go into this section 
of the TBO Link setup to assign it to the proper GL Account. 

 

 (Figure 1.36) 

Center 

The Center section (Figure 1.37) is associated with the Profit Centers set up in R.O. Writer TM. If you add 
new Profit Centers in R.O. Writer TM, you will need to go into this section of the setup to assign it to the 
proper GL Account. 

 

 (Figure 1.37) 
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Suppliers 

The Suppliers section (Figure 1.38) is associated with the Suppliers set up in R.O. Writer TM.  If you add a 
new Supplier in R.O. Writer TM, you will need to go into this section of the setup to assign it to the proper 
GL Account.  Note: When one of your vendors is already set up in Quick Books® you need to be sure the 
spelling matches exactly or else upon importation of activity QuickBooks® will create a new account for the 
vendor.  

 

 

 

 

 

 

 

                                                                                                                                     (Figure 1.38) 

Entry Type 

The Entry Type section (Figure 1.39) allows you to configure which types of transactions are processed and 
exported to the Accounting software.   

 

 (Figure 1.39) 
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Entry Group 

The Entry Group section (Figure 1.40) allows you to configure Groups for use in other areas of mapping. 

 

 (Figure 1.40) 
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CHAPTER 5 – Frequently Asked Questions 
 

How do I contact technical support?   

If you need technical support regarding the Accounting Link please contact: 

THE BACK OFFICE, LLC. 

Phone (515)-964-8261  or  1-866-964-9699 

Fax (515)-964-5779 

Email billf@tboffice.com 

 

Can I allow other users to log into The Accounting Link?   

Yes.  To set up additional users log into the Accounting Link with the Auto Open check box unchecked.  Go 
to the setup screen and pick the Users icon.  You can now assign a User Name, Description, and Password.  
*Note, giving a user Administrator rights will allow them to get into the Setup and Help windows and make 
configure changes.  Non administrator users will only have access to the quick prepare screen. 

 

What kind of maintenance is required?   

The Back Office charges an annual maintenance fee for its products.  Included with the purchase of the 
Accounting Link is one year of free maintenance and support.  After the 1st year The Back Office will send 
the customer an Annual Support Agreement.  This annual maintenance fee includes telephone and or 
electronic support for The Back Office products.  Also included are free upgrades and enhancements to The 
Back Office products as they are released.  

 

How can I ‘Reset’ all of the users who are logged in?   

Double click the Accounting Link icon and enter your Username and Password but before clicking OK make 
sure the Auto Open Check Box is not selected.  Hit OK and go to the Help Section of the Accounting Link.  
Click the “Reset” button, a box will come up saying, “The Accounting Link will now be closed.  Restart for 
settings to take affect.”  Click OK. 
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How can I backup my Accounting Link Data?   

There are several ways to back up data stored in Accounting Link.  If you are already using a program to 
back up other computer programs for you business you can use the same process to back up data stored in 
Accounting Link.  Simply choose the Data Folder from the TBOLink file to backup.  Performing this step 
insures that in the event of a computer malfunction, the data and settings stored in the Accounting Link will 
be saved.    

The Accounting Link also features a Backup function located in the Setup window.  To access this feature 
log into the Accounting Link normally but ensure the Auto Open check box is unchecked.  When the 
program launches go to the Help section, and click on the Backup.  This will backup data to a selected path, 
the default path is TBOffice/TBOLink/Data.  If using this backup procedure it is a good idea to back the data 
up to a location outside the computer Accounting Link is installed on like a zip disk or a network.  This 
insures that in the case of a computer malfunction, the data is safe.  To change the export path go into the 
Setup menu in Accounting Link and click Options, then change the Backup Path to a desired location. 

 

How can I send my Accounting Link data to tech support?   

Log into the Accounting Link with the Auto Open checkbox unchecked.  Go to the Help screen and check 
the Upload icon.  This will automatically upload your data to the TBOffice tech support for review. 

 

How can I archive history from Accounting Link?  

Log into the Accounting Link with the Auto Open check box unchecked.  Go to the Help menu and click the 
Archive.  Choose how far back you would like to archive data from the Accounting Link the hit the Archive 
button.  Performing this creates a Zip file in the TBOffice, Data folder. 

 

How can I keep Accounting Link up-to-date as new versions come out?  

Every so often The Back Office updates our software to make it as compatible as possible with R.O. Writer 
TM.  Generally when you update R.O. Writer TM it is a good idea to update Accounting Link.  Included in the 
annual maintenance fees is the ability to update your version of Accounting Link for free.   

Soon we should have a link on our website www.tboffice.net that will keep users up to date on new versions 
of the Acct Link Software.  We strive to make the transition between R.O. Writer TM and your accounting 
package as seamless as possible.  If you have any questions about compatibility issues please don’t hesitate 
to contact us.    
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I have already processed a day but it has shown up again in the dates to process window (Figure 1.28).  
Why is this?   

Anytime a date shows up in the Dates to Process window, Accounting Link has found activity in R.O. 
Writer TM for that day.  The most common reason for this is that an R.O.  or payable transaction was 
backdated to that day.   

Solution – Click on the date from the Dates to Process window to highlight it, and then click the Select 
button to process the new transactions.  This will prepare entries for only the new transactions closed to 
that date.  You can view exactly what new transactions were closed to that date by selecting the details 
tab.  Once the new activity has been processed it will be added to any activity for that date that was 
already processed.  This will allow you to print out a new summary report from R.O. Writer TM and 
tie it out to the Accounting Link summary screen.  When imported into your accounting system the 
new activity will be added to the activity already processed for that date. 

 

 (Figure 1.28) 

 

I accidentally exported and overwrote a previous day’s exported file before I imported it. What should 
I do?  First, you need to figure out which day’s activity was on the file you overwrote.  You can do this by 
looking in your accounting system to see the last day activity from the Accounting Link was imported (every 
accounting system has various reports to show daily activity).  When you have narrowed down which days 
need to be exported again, go to the details tab in the Accounting Link.  In order to make these transactions 
available for export you must reset all the transactions that need to be exported again (refer to Page 22 on 
Resetting).  Once this is done you can go to the Export tab and export the transactions again. 
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I get a message that says some function (Deposit, Export, etc) of Accounting Link is in use.  What 
should I do?  This message usually occurs when Accounting Link was shut down abnormally.  To correct 
this Accounting Link needs to be Reset.  To reset this Log into Accounting Link with the Auto Open check 
box unchecked and click the Help tab.  Click the Reset icon.  A message box will appear telling you the 
Accounting Link will be closed and to restart the program.  Click Ok. 

 

When Using the Accounting Link I get an error message.  What should I do?  If this happens please 
contact Accounting Link tech support at 1-866-964-9699 before proceeding further. 
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APPENDIX A: “PEACHTREE IMPORT TEMPLATE SETUP” 
 
There are three types of entries that can be imported into Peachtree from The Accounting Link: 
 

1) Journal Entries (General Ledger-General Journal) 
2) Payable Invoices (Accounts Payable-Purchase Journal) 
3) Payments (Accounts Payable-Payments Journal) 

 
You must setup each of these templates and then use the appropriate template to import the information 
(from a file) into Peachtree. 
 
Begin by Selecting ‘File’ and ‘Select Import/Export’ from the main menu. 

 
 
This is the main window for importing data and maintaining your import templates.  On the left hand side 
you will see the template groups.  We will use ‘General Ledger’ to setup the import template for our Journal 
Entries and ‘Accounts Payable’ to setup the import templates for our Payables Invoices and Payments. 
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Setting up the Journal Entries (General Ledger-General Journal) import template. 

 
a) Select the General Ledger template group from the list on the left hand side. 
b) Select General Journal from the list on the right hand side. 

c) Click on the ‘Import’ button ( ) in the toolbar.  This will bring up the following window: 
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d) Click the ‘Show None button ( ) to remove all of the checks in the ‘Show’ column. 
e) Starting from the top of the list, click the check box in the show column for the following fields: 

a. Date 
b. Reference 
c. Number of Distributions 
d. G/L Account 
e. Description 
f. Amount 

f) Select the ‘Options’ Tab.  This will bring up the following window: 

 
 
g) Make sure the check box next to “First Row Contains Headings” is UNCHECKED. 

h) Click on the  button and browse to the folder on your hard drive that will contain the file to be 
imported. 
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i) If the file does not already exist on your hard drive, type the file name including “.csv” extension in 

the file name text box.  When finished, select the open button. 
Note: this is the name of the file that this template will always look for when you use it to import a 
file.  If the name of the file is different than what you save in this template, you will need to browse to 
it when you use the template. 

j) Click on the ‘Save’ button ( ) to save your template.  You will be prompted to give your 
template a unique name to save it as.  Example “Journal Entry-ROW”.   

k) Click the ( ) to close the template and return to the main import/export window. 
 

  
Setting up the Payable Invoices (Accounts Payable-Purchase Journal) import template. 

 
a) Select the Accounts Payable template group from the list on the left hand side. 
b) Select Purchase Journal from the list on the right hand side. 

c) Click on the ‘Import’ button ( ) in the toolbar.  This will bring up the following window: 
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d) Click the ‘Show None button ( ) to remove all of the checks in the ‘Show’ column. 
e) Starting from the top of the list click the check box in the show column for the following fields: 

a. Vendor ID 
b. Invoice # 
c. Date 
d. Date Due 
e. Accounts Payable Account 
f. Number of Distributions 
g. Description 
h. G/L Account 
i. Amount 

f) Select the ‘Options’ Tab.  This will bring up the following window: 
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g) Make sure the check box next to “First Row Contains Headings” is UNCHECKED. 

h) Click on the  button and browse to the folder on your hard drive that will contain the file to be 
imported. 
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i) If the file does not already exist on your hard drive, type the file name including “.csv” extension in 

the file name text box.  When finished, select the open button. 
Note: this is the name of the file that this template will always look for when you use it to import a 
file.  If the name of the file is different than what you save in this template, you will need to browse to 
it when you use the template. 

j) Click on the ‘Save’ button ( ) to save your template.  You will be prompted to give your 
template a unique name to save it as.  Example “AP Invoices-ROW”.   

k) Click the ( ) to close the template and return to the main import/export window. 
 

  
Setting up the Payments (Accounts Payable-Payments Journal) import template. 
 

l) Select the Accounts Payable template group from the list on the left hand side. 
m) Select Payments Journal from the list on the right hand side. 

n) Click on the ‘Import’ button ( ) in the toolbar.  This will bring up the following window: 
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o) Click the ‘Show None button ( ) to remove all of the checks in the ‘Show’ column. 
p) Starting from the top of the list, click the check box in the show column for the following fields: 

a. Vendor ID 
b. Check Number 
c. Date 
d. Cash Account 
e. Total Paid On Invoice(s) 
f. Discount Account 
g. Detailed Payments 
h. Number of Distributions 
i. Invoice Paid 
j. Description 
k. G/L Account 
l. Amount 

q) Select the ‘Options’ Tab.  This will bring up the following window: 
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r) Make sure the check box next to “First Row Contains Headings” is UNCHECKED. 

s) Click on the  button and browse to the folder on your hard drive that will contain the file to be 
imported. 
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t) If the file does not already exist on your hard drive, type the file name including “.csv” extension in 

the file name text box.  When finished, select the open button. 
Note: This is the name of the file that this template will always look for when you use it to import a 
file.  If the name of the file is different than what you save in this template, you will need to browse to 
it when you use the template. 

u) Click on the ‘Save’ button ( ) to save your template.  You will be prompted to give your 
template a unique name to save it as.  Example “Payments-ROW”.   

Click the ( ) to close the template and return to the main import/export window.
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APPENDIX B: “LICENSE AGREEMENT” 
IMPORTANT: Please read the following License Agreement thoroughly.  If you Accept the 
agreement, click on the Accept button.  To cancel the installation, click on the 
Decline button.  
 
This is a legal agreement between Licensee and THE BACK OFFICE, LLC. ("THE BACK 
OFFICE").  THE BACK OFFICE is willing to license this software to you only upon the 
condition that you accept all of the terms and conditions contained in the following 
license agreement.  Please read the terms and conditions carefully as continuing with 
the setup procedure will indicate your acceptance of all of the terms and conditions of 
the license agreement ("agreement").  If you do not agree to the terms and conditions, 
THE BACK OFFICE is unwilling to license the software to you.  
 
Definitions  
"Software" shall be taken as referring to the Accounting Link files supplied in the 
software archive and to any and all copies, updates, modifications, functionally-
equivalent derivatives, or any parts or portions thereof.  
 
"Licensor" shall be taken as referring to THE BACK OFFICE, LLC.  
 
"Licensee" shall be taken as referring to the person or business entity who purchased 
this License to use this Software or for whom such License was purchased.  
 
Grant of License  
Upon acceptance of the Agreement, as evidenced by continuing with the setup procedure, 
THE BACK OFFICE grants Licensee a non-transferable, non-exclusive, non-sublicensable 
license to use the enclosed software program (the "Software").  
 
Copyright  
The Software and the accompanying documentation may not be reproduced in any form, 
except for the sole purpose of making a backup copy for archival purposes.  You may not 
reproduce the written documentation accompanying the Software.  
 
Other Restrictions  
You may not use, copy, modify, or transfer the Software or any copy, modification, or 
merged portion, in whole or in part, except as expressly provided for in this 
Agreement.  Licensee shall not decompile, disassemble, or reverse engineer any of the 
Software or attempt to do so.  Licensee shall not rent, lease, sublicense, or transfer 
the Software.  
 
Proprietary Rights  
Other than any license granted herein, Licensor retains exclusive proprietary rights 
(including all rights, title, and interest) in the Software.  Licensee agrees not to 
represent that the Licensor is affiliated with or approves of Licensee's application 
software in any way.  Licensee shall not use Licensor's name, trademarks, or any 
Licensor designation in association with Licensee's application software.  
 
Termination  
This license is effective until terminated.  Licensee may terminate it at any time by 
destroying all copies of the Software covered by this Agreement and all support files 
generated by the Software.  It will also terminate if Licensee fails to comply with any 
term or condition of this Agreement.  Licensee agrees that upon such termination to 
destroy this Software, including all copies, functionally-equivalent derivatives, and 
all portions and modifications thereof in any form.  
 
Warranties: Disclaimers  
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THIS SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR  PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE 
OF THE SOFTWARE IS WITH YOU.  SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (NOT THE BACK 
OFFICE, LLC.) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.  
 
The Back Office does not warrant that the functions contained in this Software will 
meet your requirements or that the operation of this Software will be uninterrupted or 
error-free.  
 
Remedies: Limitations  
Licensee's sole and exclusive remedy against Licensor shall be, at Licensor's sole 
discretion:  
a.  the replacement of any diskette not meeting The Back Office's "Limited Warranty" 
and which is returned to The Back Office, or  
b.  if The Back Office is unable to deliver a replacement diskette which is free of 
defects in materials or workmanship, you may terminate this Agreement by returning this 
Software and your money will be refunded.  
 
IN NO EVENT WILL THE BACK OFFICE, LLC. BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SALES, INJURY TO PERSON OR PROPERTY OR ANY OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THIS SOFTWARE EVEN IF 
THE BACK OFFICE, LLC. OR ITS AUTHORIZED REPRESENTATIVE(S) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.  IN NO EVENT SHALL 
LICENSOR'S LIABILITY EXCEED AMOUNTS PAID TO LICENSOR BY LICENSEE UNDER THE TERMS OF THE 
AGREEMENT.  
 
General  
Licensee may not sublicense, assign or otherwise transfer this License or Software 
except as expressly provided in this Agreement.  Any attempt to otherwise sublicense, 
assign, or transfer any of the rights, duties or obligations hereunder is expressly 
prohibited and will terminate this Agreement.  
 
By continuing the setup procedure, Licensee acknowledges that Licensee has read this 
agreement, understands it, and agrees to be bound by its terms and conditions.  
Licensee further agrees that this is the complete and exclusive statement of the 
agreement between us, which supercedes any proposal or prior agreement, oral or 
written, and any other communications between us relating to the subject matter of this 
agreement.  
 
This Agreement will be governed by the laws of the Iowa, USA.  
 
If you Accept the agreement, click on the Accept button.  To cancel the installation, 
click on the Decline button. 
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APPENDIX C: “SUPPORT AGREEMENT” 
The Back Office shall provide support and updates for the above referenced Software 
subject to the following conditions: 
 
Remote Support:   
The Back Office agrees to make available to Licensee telephone and or electronic 
support during The Back Office's normal business hours (8:00am to 5:00pm Central time, 
Monday through Friday, excluding holidays).  Licensee must have Internet connection and 
a working copy of PCAnywhere (or other acceptable remote desktop sharing software) for 
use in diagnosing problems.  
 
Fees: 
Licensee agrees to pay The Back Office an annual fee for support in accordance with the 
charges referenced above.  All fees are payable in advance at the time of signature of 
this agreement. 
 
Malfunction Correction: 
The Back Office will provide a reasonable resolution or 'fix' to Software malfunctions, 
errors or problems in a timely manner.  The Licensee must provide adequate information 
and documentation to enable The Back Office to recreate the malfunction, error or 
problem.  
 
General:  
The Back Office shall have no responsibility for hardware or software which has been 
subject to improper use, accident, neglect or modification.  It is beyond the scope of 
support provided by The Back Office to train and/or Support software not manufactured 
buy us, including but not limited to Microsoft Windows, Microsoft Internet Explorer and 
PCAnywhere. 
 
Enhancements and Releases: 
The Back Office may from time to time, at its discretion, issue Enhancements, Releases 
and Database Updates to improve functionality and useful of the Software.  Licensee 
will receive (via internet) at no charge all Updates to the Software issued by The Back 
Office during the term of this agreement.  Such Updates will be distributed to the 
Licensee within 12 months after The Back Office has made it available to Licensee, The 
Back Office will have no further obligation to provide support on those parts of the 
Software updated by such update. 
 

 
 
 
 
 


